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• Cài đặt Endnote

• Tổng quan tài liệu

• Giới thiệu các cách trích dẫn tài liệu

• Quản lý chỉ mục

• Nhập tài liệu để quản lý

• Quản lý tài nguyên

• Trích dẫn tài liệu vào bài viết

• Chỉnh sửa kiểu trích dẫn

• Tìm kiếm tài liệu



TẠI SAO CẦN THAM KHẢO Y VĂN?



Tổng quan tài liệu
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• Tại sao cần tham khảo y văn?

– Tránh việc lập lại các công trình đã làm từ trước

– Thấy được một bức tranh toàn diện liên quan đến vấn  

đề quan tâm

– Nghiên cứu của mình đang ở đâu trong bối cảnh chung

– Phát hiện những bằng chứng mới

– Khuyến khích suy nghĩ một cách khách quan

– Tự mở mang kiến thức

– Hiểu rõ các thuật ngữ



Tổng quan tài liệu
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• Tại sao cần tham khảo y văn?

– Tìm hiểu các nhà nghiên cứu khác đã phát hiện và báo cáo

– Tiếp tục / bắt đầu từ thanh quả của các nghiên cứu trước

– Tìm những khuyến cáo từ các nghiên cứu trước

– Tránh lặp lại các sai lầm từ nghiên cứu trước

– Quen thuộc hơn với những loại thiết kế nghiên cứu đã được  

sử dụng

– Cho những lí lẽ thuyết phục tại sao đề tài nghiên cứu là cần

thiết

– Tìm được chuyên gia trong vấn đề nghiên cứu



Khi nào cần tham khảo y văn?



Tổng quan tài liệu
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• Khi nào cần tham khảo y văn?

- Ví dụ: một dàn ý nghiên cứu mẫu

- Đặt vấn đề

- Tổng quan tài liệu

- Phương pháp nghiên cứu

- Kết quả

- Bàn luận

- Kết luận

- Kiến nghị



Số lượng tài liệu tham khảo bao nhiêu là đủ?



Tổng quan tài liệu
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• Tham khảo bao nhiêu là đủ?

- Tùy thuộc vào nghiên cứu

- Tùy thuộc mức độ tranh luận về vấn đề

- Tùy thuộc vào khối lượng công việc

- Tùy vào thời lượng cho phép

- Tùy thuộc vào khả năng hiểu và tổng hợp



Phân loại tài liệu tham khảo

- Con người, nhóm người, tổ chức

- Thông tin đã xuất bản

- Thông tin chưa xuất bản

- Internet

10



Phân loại tài liệu tham khảo
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Cấp độ của nguồn thông tin

Địa phương

• Số liệu của bệnh viện hay phòng khám từ các thống kê định  

kì

• Ý kiến, niềm tin của các nhân vật chủ chốt

• Quan sát lâm sàng, báo cáo các tai biến

• Điều tra hay báo cáo hàng năm

• Niên giám thống kê của địa phương

• Sách, bài báo khoa học, báo chí…



Phân loại tài liệu tham khảo

Cấp độ của nguồn thông tin

Quốc gia

• Tạp chí khoa học quốc gia

• Tạp chí của các trường đại học

• Tạp chí của các viện nghien cứu

• Sách vở trong thư viện của trường đại học

• Thư viện của WHO, UNICEF

– Tạp chí Y học thực hành: http://www.yhth.vn/

– Tạp chí y học TPHCM: http://tcyh.yds.edu.vn/

– Tạp chí Y học Đại học Huế:

http://www.hueuni.edu.vn/hueuni/issue.php

20

http://www.yhth.vn/
http://tcyh.yds.edu.vn/
http://www.hueuni.edu.vn/hueuni/issue.php


Phân loại tài liệu tham khảo

Cấp độ của nguồn thông tin

Quốc gia

• Văn bản, báo cáo, số liệu thô từ

– Bộ y tế http://www.moh.gov.vn

– Tổng cục thống kê http://www.gso.gov.vn

– Thông tin y học Việt Nam http://www.cimsi.org.vn/

– Các tổ chức phi chính phủ, VD: 

http://www.unicef.org/vietnam/v/
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Phân loại tài liệu tham khảo

Cấp độ của nguồn thông tin

Quốc tế

• Các tạp chí khoa học, tạp chí chuyên ngành

• Asia Pacific Journal of Public Health (APJPH)

• British Medical Journal (BMJ)

• Journal of American Medical Association (JAMA)

• Lancet

• Clinical Nursing Research: http://cnr.sagepub.com/

• Journal of research in nursing: http://jrn.sagepub.com

• Các ấn bản của WHO, UNICEF, UNFPA…

• Các sách, tài liệu khoa học kinh điển

• Google Scholar http://scholar.google.com
22

http://cnr.sagepub.com/
http://jrn.sagepub.com/
http://scholar.google.com/


Phân loại tài liệu tham khảo

Cấp độ của nguồn thông tin

Quốc tế

• Chương trình HINARI

• WHO quản lý

• Bắt đầu từ 2002 với 1500 tạp chí và 6 nhà xuất bản lớn (Springer,

Wiley…)

• Dành cho các nước đang phát triển

• Hiện có khoảng 14.900 tạp chí và 60.000 sách điện tử (ebook)

• 115 quốc gia tham gia

• Tại Việt Nam có hơn 100 cơ quan tham gia

23

https://partnership.who.int/hinari



Tìm kiếm tài liệu tham khảo
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• Tiến hành hồi cứu tài liệu

– Đọc và hiểu thông tin nền tảng

– Liệt kê tất cả các từ khóa

– Sắp xếp từ khóa theo thứ tự quan trọng, ưu tiên

– Tìm kiếm tài liệu theo từng từ khóa cho đến khi thông tin  

bảo hòa

– Liệt kê thư mục để ghi tài liệu tham khảo



Đánh giá tài liệu tham khảo
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• Nguyên tắc

– Sát hợp

• Liên quan trực tiếp đến biến số nghiên cứu

– Tiêu hóa và tổng hợp

• Giải quyết sự khác nhau về dân số nghiên cứu và  

phương pháp nghiên cứu của từng đề tài

– Phê phán



Kỹ năng cần có khi đọc TLTK
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1. Interpretation (phiên giải)

2.Analysis (phân tích)

3.Evaluation (đánh giá)

4.Synthesis/ Inference (tổng hợp/ suy luận)

5.Explanation/ Justification (giải thích/ chứng minh)

6.Self-regulation/ Reflection (tự điều chỉnh/ suy ngẫm)



Tính giá trị của thiết kế NC

39
Ý kiến của chuyên gia

Nghiên cứu định tính

Nghiên cứu cắt ngang

Nghiên cứu một ca/hàng loạt ca

Nghiên cứu bệnh chứng

Nghiên cứu đoàn hệ

RCT

Hồi cứu y 
văn 

NC gộp



Trích dẫn nội dung
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• Cấu trúc đoạn văn

– Câu chủ đề → Giải thích → Ví dụ → Bằng chứng → Trích

dẫn

• Tránh mô tả từng nghiên cứu mà nên:

– Nhóm các nghiên cứu giống nhau

– So sánh đối chiếu

– Phân tích điểm hay, điểm chưa tốt của bài báo

• Nên hạn chế việc tự đặt câu hỏi và tự trả lời → đi ngay vào  

vấn đề



Trích dẫn nội dung

• Ví dụ 1:

Năm A, nghiên cứu của tác giả Nguyễn Văn A tại tỉnh A trên đối

tượng A cho thấy tỉ lệ nhiễm trùng bệnh viện là 10%. Các yếu tố

liên quan đến nhiễm trùng bệnh viện bao gồm A, A’, A’’.

Năm B, nghiên cứu của tác giả Nguyễn Văn B tại tỉnh B trên đối

tượng A cho thấy tỉ lệ nhiễm trùng bệnh viện là 15%. Các yếu tố

liên quan đến nhiễm trùng bệnh viện bao gồm B, B’, B’’.

Năm C, nghiên cứu của tác giả Nguyễn Văn C tại tỉnh C trên đối

tượng C cho thấy tỉ lệ nhiễm trùng bệnh viện là 20%. Các yếu tố

liên quan đến nhiễm trùng bệnh viện bao gồm C, C’, C’’. 43



Trích dẫn nội dung
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• Ví dụ 2:

Các nghiên cứu trước đây cho thấy tỉ lệ nhiễm trùng bệnh viện tương  

đối cao và doa động từ 10 đến 20% (Nguyễn Văn A, Nguyễn Văn B,  

Nguyễn Văn C). Tuy nhiên, sự khác biệt về tỉ lệ này giữa các nghiên  

cứu có thể do thiết kế nghiên cứu, dân số nghiên cứu cũng như thời  

điểm tiến hành nghiên cứu. Ví dụ, tỉ lệ nhiễm trùng bệnh viện trên  

bệnh nhân A chỉ vào khoảng 10% (Nguyễn Văn A) trong khi tỉ lệ này

trên bệnh nhân C là 20% (Nguyễn Văn C). Ngoài ra, có thể thấy được  

tỉ lệ của Nguyễn Văn A được thực hiện trong bối cảnh năm A khi mà  

hệ thống y tế…



Trích dẫn nội dung
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• Trích dẫn trực tiếp (sao chép) các từ ngữ của một tác giả:

– Trích dẫn trực tiếp phải đặt trong ngoặc kép “….” và kết thúc

với một phần ghi nguồn trích dẫn

– Nếu hơn 5 từ được sao chép giống từng từ một của một nguồn  

tài liệu được xuất bản và không chỉ rõ tài liệu trích dẫn, thì  

được coi là đạo văn ngay cả khi tác giả đưa ra nguồn tài liệu  

trong bài viết và/hoặc trong danh mục tham khảo



Trích dẫn nội dung
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• Viết lại câu

– Trích dẫn, tổng hợp gián tiếp hoặc viết lại câu bằng cách khác  

các từ ngữ, ý tưởng của một tác giả hoặc những dữ kiện, số  

liệu do tác giả đó báo cáo

– Không cần dùng dấu ngoặc kép đối với những câu viết lại,

nhưng cần thiết phải ghi trích dẫn cuối câu

– Việc liệt kê số trang là không cần thiết khi viết lại câu, trừ

trường hợp tài liệu tham khảo có quá nhiều trang



Trình bày TLTK
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Các kiểu trích dẫn

1. Đánh số thứ tự trên văn bản để tham chiếu đến tài liệu  

tham khảo. Sau đó liệt kê tài liệu tham khảo theo thứ tự sử

dụng (Vancouver)

2. Viết họ/tên của tác giả, năm xuất bản và số trang được  

trích dẫn để tham chiếu đến tài liệu tham khảo (Harvard)



Trình bày TLTK

26

Ví dụ:

Smoking is one of the most important issues in public health. According

to  WHO, smoking is the most wide spread addiction. Statistics show that 

in  90 years there have been 1.1 billion smokers in the world, among 

them  47% men and 12% women out of the whole population (1). Only in 

China,  there are nearly 350 million smokers, ever-smoking rates in males 

and  females aged 15 and over were 66.0% and 3.1% respectively with 

an  average number of cigarette per day is 14.8 (2).

1. Yamamoto M, Tsurugi Y, Matsuda S, Luong NA. Occupational exposure,  

environmental pollution and chronic respiratory symptoms in Vietnam. J UOEH.  

2000 Dec 1;22(4):325-37.

2. Gabel HD, Colley-Niemeyer B. Smoking in a public health agency: its relationship

to sick leave and other life-style behavior. South Med J. 1990 Jan;83(1):13-7

→Trích dẫn kiểu Vancouver



Trình bày TLTK
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Ví dụ:

• Smoking is one of the most important issues in public health. Accordingto  

WHO, smoking is the most wide spread addiction. Statistics show that in  

90 years there have been 1.1 billion smokers in the world, among them  

47% men and 12% women out of the whole population (Yamamoto et al.,  

2000). Only in China, there are nearly 350 million smokers, ever-smoking  

rates in males and females aged 15 and over were 66.0% and 3.1%  

respectively with an average number of cigarette per day is 14.8 (Gabel  

and Colley-Niemeyer, 1990).

• GABEL, H. D. & COLLEY-NIEMEYER, B. (1990) Smoking in a public health  

agency: its relationship to sick leave and other life-style behavior. South Med J,  

83, 13-7.

• YAMAMOTO, M., TSURUGI, Y., MATSUDA, S. & LUONG, N. A. (2000)  

Occupational exposure, environmental pollution and chronic respiratory symptoms  

in Vietnam. J UOEH, 22, 325-37.

→Trích dẫn kiểu Harvard



Trình bày TLTK
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Trích dẫn theo cách Việt Nam

– Trong bài viết, trích dẫn bằng số

– Tài liệu tham khảo tiếng Việt trước, tài liệu tham khảo tiếng Anh,  

Pháp… sau

– Tác giả là người Việt Nam: xếp theo thứ tự A, B, C theo tên,  

không được đảo tên lên trước họ.

– Tác giả là người nước ngoài: xếp thứ tự A, B, C theo họ.

– Tài liệu không có tên tác giả: xếp theo A, B, C theo từ đầu tiên  

của cơ quan phát hành



Trình bày TLTK
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Qui cách trình bày TLTK
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Các quy tắc trình bày tài liệu tham khảo

– Bài báo trong tạp chí, bài đăng trong 1 quyển sách

• Tên tác giả hoặc cơ quan phát hành

• Năm xuất bản: đặt trong ngoặc đơn

• Tên bài báo: không in nghiêng nhưng để trong ngoặc kép

• Tên tạp chí hoặc tên sách: in nghiêng

• Nhà xuất bản

• Số tái bản

• Nơi xuất bản

• Tập

• Số: đặt trong ngoặc đơn

• Các số trang: tiếng Việt tr.20-30; tiếng Anh pp.20-30

44. Trần Thiện Trung (2002). “Điều trị viêm dạ dày – tá tràng doH.pylory”.

Tạp chí Y học, Đại học Y dược Tp.HCM, tập 3 (8),tr.13-18.



Qui cách trình bày TLTK
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Các quy tắc trình bày tài liệu tham khảo

– Sách, luận án, báo cáo

• Tên tác giả hoặc cơ quan phát hành

• Năm xuất bản: đặt trong ngoặc đơn

• Tên sách, luận án, báo cáo: in nghiêng

• Nhà xuất bản

• Nơi xuất bản

• Số tái bản

• Các số trang: tiếng Việt tr.20-30; tiếng Anh pp.20-30

3. Nguyễn Hữu Đống, Đào Thanh Hằng (1997). Đột biến – cơ sở lý luận và

ứng dụng. NXB Nông nghiệp. Hà Nội, tr.45-60.

30. Institude of Economies (1998), Analysis of Expenditure Pattern of Urban  

Households in Vietnam, Department of Economics – Research report,  

Hanoi, pp.345-350



Qui cách trình bày TLTK
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Các quy tắc trình bày tài liệu tham khảo

– Trang web

• Tên tác giả (hoặc cơ quan chủ quản nếu không có tác giả cụ thể)

• Năm đăng tải: đặt trong ngoặc đơn

• Tên bài viết: in nghiêng

• Cơ quan chủ quản (nếu có tác giả cụ thể)

• Đường dẫn đến trang web (URL)

• Ngày truy cập

1. WHO (2007), How to conduct a big survey,

http://www.who.int/survey_info.html, accessed on 20 Oct 2009.

http://www.who.int/survey_info.html


Điều gì xảy ra khi thêm/xóa TLTK?

• Danh sách tài liệu tham khảo

33



Điều gì xảy ra khi thêm/xóa TLTK?

Thêm bài của Nguyễn Văn Hùng

34



Điều gì xảy ra khi thêm/xóa TLTK?

Thêm bài của Nguyễn Văn Hùng

Thêm bài của Nguyễn Thị Yến

35



Giới thiệu Endnote
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• Tạo và quản lý thư viện

• Tạo và quản lý tài liệu tham khảo

• Trích dẫn tài liệu theo các qui cách khác nhau

• Có thể chỉnh sửa qui cách cho phù hợp

• Truy cập thư viện hơn 100 trường đại học trên thế giới

• Tìm và download nghiên cứu toàn văn

• Quản lý bài báo toàn văn một cách có hệ thống



QUẢN LÝ CHỈ MỤC
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• Tạo thư viện mới

– Mở Endnote

– File → New → Tìm nơi lưu → Đặt tên thư viện (thamkhao.enl)

• Lưu ý: không dùng tiếng Việt có dấu để đặt tên



NHẬP TLTK ĐỂ QUẢN

LÝ

38

• Nhập thủ công từng bài trên Endnote

• Tìm từ chức năng Search bài báo của Endnote

• Tìm và download về Endnote trực tiếp từ tạp chí /  

thư viện

• Import từ file văn bản (text)



NHẬP TLTK ĐỂ QUẢN

LÝ
• Nhập vào 9 tài liệu tham khảo

39



NHẬP TLTK ĐỂ QUẢN

LÝ
• Sách

• Reference type: book

• Author: Nguyễn Hữu Đống <enter xuống hàng> Đào  

Thanh Hằng (Mỗi tác giả 1 dòng)

• Year: 1997

• Title: Đột biến – cơ sở lý luận và ứng dụng

• City: Hà Nội

• Publisher: NXB Nông Nghiệp

• Pages: tr. 45-60 40



NHẬP TLTK ĐỂ QUẢN LÝ

• Tạp chí

• Reference type: Journal Article

• Author: Trần Thiện Trung

• Year: 2002

• Title: Điều trị viêm dạ dày – tá trang do H. pylory

• Journal: Tạp chí y học

• Volume: tập 3

• Issue: 8

• Pages: tr. 13-18

• Original Publication: Đại học Y dược TP.HCM 65



NHẬP TLTK ĐỂ QUẢN LÝ

• Luận văn / luận án

• Reference type: Thesis

• Author: Bùi Chí Thương

• Year: 2004

• Title: Kết quả điều trị bảo tồn thai ngoài tử cung bằng  
nọi soi ổ bụng tại Bệnh Viện Phụ Sản Từ Dũ

• City: TP.HCM

• University: Đại học Y dược TP.HCM

• Number of Pages: tr. 15-21

• Thesis type: Luận văn tốt nghiệp bác sĩ nội trú 66



NHẬP TLTK ĐỂ QUẢN LÝ

• Báo cáo

• Reference type: Report

• Author: Institute@ <xuống hàng> of Economies

• Year: 1998

• Title: Analysis of Expenditure Pattern of Urban  
Households in Vietnam

• City: Hanoi

• Institution: Department of Economics

• Pages: pp. 345-350

• Type: Research Report

• Language: eng
43
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LÝ
• Trang web

• Reference type: web page

• Author: WHO (hoặc ghi đầy đủ World@ <xuống hàng>

Health Organization)

• Year: 2007

• Title: How to conduct a big survey

• Access Date: accessed on (truy cập ngày) 20 Oct 2009

• URL: http://www.who.int/survey_info.html

• Language: eng

• Publisher: (nếu có)
44
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Journal

Article

Author

Year

Title  

Journal

Volume  

Issue

Pages

Original  
publication 69



Gỡ bỏ chương trình

46

–Đóng tất cả các chương trình đang mở trước khi gỡ bỏ phần  

mềm

– Bấm phím Windows + R

– Trong cửa sổ hiện ra gõ vào appwiz.cpl rồi Enter

– Chọn phần mềm cần gỡ bỏ và bấm uninstall / remove

– Click Yes để xác nhận việc gỡ bỏ phần mềm
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• Chọn kiểu thể hiện

– Annotated

– Havard

– Vancouver

– VietnamE
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Tham

khảo

trang

20 - 35
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Book

Author

Year

Title

City

Publisher

Pages



Tham

khảo

trang

52 - 60

49

Thesis

Author

Year

Title

City

University

Number of
pages

Thesis  
type
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• Một số lỗi sai thường gặp

– Tài liệu tiếng Việt:

• Dư dấu chấm, dấu phẩy ở cuối tên tác giả

• Nhiều tác giả trên cùng 1 dòng

– Tài liệu tiếng Anh:

• Không có chữ eng trong phần Language

– Không cài đặt và chọn VietnamE khi thể hiện

72



CHỈNH SỬA KIỂU TRÍCH DẪN

51

• Trường hợp 1: số tài liệu tham khảo nằm phía trên chữ (1)

• Trường hợp 2: số tài liệu tham khảo nằm trong ngoặc đơn

(1)

• Trường hợp 3: Thêm một dạng tài liệu khác



CHỈNH SỬA KIỂU TRÍCH DẪN

• Edit → Output Styles → Edit “VietnamE”

Citations = Chỉnh sửa trên nội dung

bài viết

52

Bibliography = Chỉnh sửa trong  
danh sách tài liệu tham khảo  

(cuối bài viết)
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• Trường hợp 1: số tài liệu tham khảo nằm phía trên chữ

– Edit → Output Styles → Edit “VietnamE”

– Citations → Templates

• Tô chọn chữ |[Bibliography Number]

• Bấm vào biểu tượng phía trên

• Chọn Save để lưu

• Đặt tên là “VietnamE Super”

• Vào bài viết chọn kiểu trích dẫn VietnamE Super

53



CHỈNH SỬA KIỂU TRÍCH DẪN
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• Trường hợp 2: số tài liệu tham khảo nằm trong ngoặc đơn

– Edit → Output Styles → Edit “VietnamE”

– Citations → Templates

• Xóa ngoặc vuông trong mục |[Bibliography Number]

• Thay ngoặc vuông thành ngoặc đơn

• Chọn Save để lưu

• Đặt tên là “VietnamE Round”

• Vào bài viết chọn kiểu trích dẫn VietnamE Round
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• Trường hợp 3: Thêm một dạng tài liệu khác

– Edit → Output Styles → Edit “VietnamE”

– Bibliography → Templates

• Reference Type → Chọn dạng tài liệu tham khảo khác

– Ví dụ: chọn Conference Paper

• Insert Field → Chọn Author

• Insert Field → Chọn Year → Thêm ngoặc đơn

• Insert Field → Chọn Title

• Insert Field → Chọn Conference Name → In nghiêng

• Insert Field → Chọn Date

• Insert Field → Chọn Conference Location

• Insert Field → Chọn Pages 79
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Cách 1: Endnote tìm giúp
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Cách 1: Endnote tìm giúp
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Cách 1: Endnote tìm giúp

• Chọn Preview

• Chọn Style là Annotated thay vì VietnamE

• Xem tóm tắt bài báo

• Xóa những bài báo không cần bằng phím Delete

58

Cách 2: Tự tìm thủ công (google, google scholar) 



Download trực tiếp từ tạp chí
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• Truy cập tạp chí Journal of Clinical Nursing

http://onlinelibrary.wiley.com/journal/10.1111/(ISSN)1365-2702

• Tìm bài báo bằng cách gõ từ khóa vào mục Search

– Ví dụ: adolescent

• Click vào bài báo

• Chọn Export Citation for this Article

• Trong mục Export Citation, chọn:

: Endnote

: Citation &

Abstract

– Format

– Export type

– Submit

• Click vào file vừa download (có đuôi là .enw)

http://onlinelibrary.wiley.com/journal/10.1111/(ISSN)1365-2702


Download trực tiếp từ tạp chí
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• Truy cập tạp chí American Journal of Nursing

http://journals.lww.com/ajnonline/pages/default.aspx

• Tìm bài báo bằng cách gõ từ khóa vào mục Search

– Ví dụ: depression

• Click vào bài báo

• Chọn Export to Citation Manager

• Trong mục Export To, chọn:

– Endnote

– Export

• Click vào file vừa download (có đuôi là .enw)

http://journals.lww.com/ajnonline/pages/default.aspx


Download trực tiếp từ thư viện
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Download trực tiếp từ thư viện
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• Truy cập trang www.library.qut.edu.au

• Trong mục Search, nhập tên sách cần tìm

– Ví dụ: viral hepatitis

• Click vào dấu cộng (+) bên phải tài liệu (save this item)

• Bấm vào Save items (1)

• Chọn Endnote

• Click vào file vừa download (có đuôi là .ris)

http://www.library.qut.edu.au/
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